Target for ArcGIS How-To Guide

Target 3D in Target for ArcGIS
Target 3D was developed for the Target for ArcGIS system to enable you to display drillhole, surface and other data types
in an interactive three-dimensional environment. The Target 3D Viewer enables three-dimensional viewing of your data.
Drillholes are displayed in their "true" three-dimensional location and can have up to two different data types plotted along
their trace.
Grids created in "sectional" views (e.g., from Target or Interactiv IP applications) can be displayed directly into the 3D view,
in their correct orientation, using Geosoft’s "on-the-fly" technology. Other grids and images (including bitmaps and jpegs)
can be opened and easily located in any specified orthogonal plane.
3D "Voxel grids" can also be displayed in a 3D drillhole map and modified using the Target 3D Tool. 3D Voxels can be
created using the Voxels|Grid Voxel menu item, on the Target 3D Toolbar.
Using the Target 3D Tools enables you to interactively control the transparency of individual items, enabling data to be
displayed with a cumulative (light-table) effect. Data such as MapInfo tables and 2D DXF files can be imported directly into
the 3D environment and drawn on any surface displayed in the current 3D view.

Working with the Target 3D Tool
You can begin creating a Target 3D view once all the appropriate project information has been imported into your drillhole
databases; collar, survey, assay, and any other data that you are using in your drillhole project.

Selecting an Area of Interest
To begin, we need to select the area that we would like to concentrate on from the Hole Selection Tool . This will enable us
to display only the area of the project that is of interest to us.
To Select Target 3D Drill Area
1. On the Target Drillhole toolbar, click Selection.
2. Select Selection tool. The Hole Selection Tool dialog appears. The dialog will display all drill-holes that are loaded
into your project and those that are currently selected will be colour-filled.
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3. Click the Select None button to deselect all holes. Ensure the Selection Mode is set to Select.
4. Use the Select/Deselect using rectangle tool or the Select/Deselect using polygon tool to define a rectangle or
polygon around the holes required.
If additional holes need to be added or removed there are a number of methods for doing so using this tool, for
more information click the Help button.
5. Click OK and the holes within the defined boundary are selected for plotting.

Create a 3D Voxel Grid
Users now have the ability to create a 3D Voxel grid, using 3D Kriging or Inverse Distance Weighted gridding,

Creating a Target 3D Voxel Grid
In addition to creating and displaying 3D Voxel Models, additional tools are available enabling users to report and modify
information about Geosoft Voxel Models, including statistical and coordinate system information.
Users can also import Geosoft (GDB and XYZ) files, GOCAD and UBC (3D Model and MSH) files and Datamine (Point,
Wireframe and Block Models) files. Users can also export Geosoft Voxel files (.Geosoft_Voxel) to Geosoft (GDB and
XYZ), GOCAD and UBC files.
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To Create a Target 3D Voxel Grid
1. Select the holes you would like included in your Target 3D Voxel grid using one of the Hole Selection Tool options.
This was shown in the previous “Selecting an Area of Interest“ step.
2. From the Target Drillhole toolbar, select Voxels.
3. Select 3D Gridding from Current Geosoft Database .
The 3D Gridding dialog is displayed.

4. Select the Data to grid from the dropdown list.
5. Specify the Output voxel file name.
6. Specify a voxel Cell Size in the units of the X,Y,Z coordinate system of the data. The Calculate button to right of the
field will calculate a default value for your data based on the statistical average separation between data points in the
dataset.
To access advanced gridding parameters, such as the Log and Log/Linear interpolation options, click More.
Note that using the logarithm of the original values can be a very effective way to reduce distortion in highly
skewed data, such as geochemical assays.
7. When you have completed assigning 3D Gridding parameters, click OK to create your voxel grid file. The Target 3D
Voxel can now be displayed in the Geosoft 3D Viewer and plotted to a 3D Map.

Sampling a Voxel to GDB locations
The new Sample a Voxel capability (Voxels | Sample a Voxel) enables you to extract values from a Geosoft voxel and
append them to a Geosoft database at each X, Y, Z location within that databases. All voxels, including lithology voxels,
can be sampled. This capability is useful in data verification to compare original database values to interpolated voxel
values, or can be used to add a new channel containing voxel values to a database that contains a different data type (e.g.
Geochemical voxel values to a Lithology database).

Create a Target 3D Map
Target 3D maps enable you to display your drillhole data, including drillhole traces and gridded data, from any perspective in
3 dimensions, making it easier to determine any relationship that may exist between surface and sub-surface features.
You can also now create a 3D Voxel grid, using 3D Kriging gridding or Inverse Distance Weighted gridding,

www.geosoft.com

3

Target for ArcGIS How-To Guide

Creating a Target 3D Map
Before you can start creating your Target 3D maps you first must select the drillholes you want to view in your
section.
The Target for ArcGIS 3D map options are provided in easy-to-use tab dialogs, enabling quick access to all the settings
from a single dialog. The dialog includes sensible defaults; enabling easy creation of your 3D map.
To Create a Target 3D Map
1. On the Target Drillhole toolbar, click the Generate 3D Drillhole Plot button.
The Page Layout tab, on the 3D Map Parameters dialog, is displayed by default.

2. The following page layout parameters can be controlled from this tab:
Background Colour of the 3D view
Axis Colour and Font used for annotating the 3D view
Plot Legend (right side of map), including company Logo (image file) and specifying the map Titles
3. Select the Hole Traces tab.
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4. This tab dialog includes the following drillhole trace parameters:
Colour of the Hole Trace
Hole Labels including location, annotations, text size, colour and font
Depth Ticks (annotations etc.) along the hole trace
5. Select the Data tab.
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6. The Data and Plot types are selected from drop-down lists, just as you would select data for your Plans or Sections
to be plotted.
In Target 3D only two sets of data can be plotted down hole along the trace (Left side and Right side). When
these data appear in the 3D Viewer, the point-of-view will always remain the same, no matter how the image
is rotated, panned or zoomed.
7. In the Plotting Orientation section, select to plot your data as Perpendicular to trace or Horizontal to the hole trace.
8. Plan oriented Gridded Data can be created from this tab. The three available gridding methods are Minimum
curvature, Kriging and a TIN based technique. To define the Gridded data parameters, click the Define button. The
specified Gridding dialog will be displayed.
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The example above shows an Au Assay channel being gridded using Minimum Curvature Gridding.
9. You can add a File name tag to the grid; this is useful when distinguishing between grids created using different
gridding parameters.
10. The Cell size can set here, which is one quarter the average data separation based on a statistical average.
11. The Colour zone file can also be left to the default file name, or you can create and save your own custom zone file
(*.itr, *.tbl, *.zon) using the Define button.
12. The Location section enables you to specify the Relative Level (elevation) of the grid and the Averaging interval; the
average of data located within the specified Averaging Interval either side of the Relative Level will be used to
calculate the grid.
13. The Multiple Grids section enables you to specify the Number of grids to create and at what Increment. (For example,
3 grids with a Relative Level of 225 and an Increment of 50 downwards, you will create grids at 225RL, 275RL and
325RL).
14. To specify additional gridding parameters, such as Log options etc., click the Advanced gridding options… button.
The Advance Options dialog is displayed.
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The Advanced Options for Minimum Curvature Gridding are shown above. For detailed technical information,
click the Help button.
15. When you are satisfied with your selections, click OKon the Advanced Options dialog.
16. The final parameter on the Gridding parameters dialog is Transparency. Using the slider you can control the level of
transparency of the gridded data in the 3D view. Note that you can also adjust the grid transparency in the 3D Viewer.
17. Click OK on the Gridding dialog to return to the 3D Map Parameters dialog.
18. Select the Topography tab.
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19. Check the Plot topography box to enable the topography parameters.
20. Then, using the Browse buttons, locate the Topography grid file and the Overlay grid on topography file.
Note that the default Geosoft *.tbl files are located in the ‘…\Oasis montaj\tbl’ folder.
21. To enable the Grid Clipping check the appropriate box, and specify the Border size in ground units. Then, using the
Transparency slider set the transparency of this plane.
22. Select the Voxel tab.
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23. Check the Plot voxel file box to enable the voxel parameters.
24. Use the Browse button to locate the Voxel grid file.
25. Use the Browse button, locate a Colour zone file.
Note that the default Geosoft *.tbl files are located in the "…\Oasis montaj\tbl"folder.
26. Then, using the Transparency slider set the transparency of the Voxel.
27. Select the Load/Save tab.
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28. This tab is used to save the Map and Data Parameters to a file for either sharing with other users or so the map
settings can be re-loaded and used at a later date.
29. Click the OK button and the Target 3D map will be created and display in your Target 3D Viewer.
You may find your Voxel obscures other data in the 3D Viewer. To view other data, open the 3D Tool (right-side of
3D Viewer window) and select the Voxel tab. Make sure the Transparency slider is set to approximately 50%. You
can also clip a voxel to specific X, Y, Z or data values using the data Clipping pane. Each of the above values has a
slider which can be used to specify the clipping extents. Note that you can also enter exact extent values using the
appropriate fields.
You can also clip a voxel along a plane with a specific Azimuth and Dip, by checking the Modify Orientation box on
any of the X, Y or Z axes on the clipping pane.

Work with the 3D Viewer
The 3D Viewer has been redesigned to streamline your workflow and for enhanced usability. The 3D Viewer provides all of
your 3D-mapping tools, functions and settings in one integrated 3D environment. When you create a 3D view, it will be
displayed in the 3D Viewer.
The 3D Viewer consists of an interactive dialog, with five main Menus (Add to 3D, Utilities, Settings, Export and Help), a
3D Viewing window, a 3D Tools window and the bottom Status Bar. For more information on each of the menu options,
click the Help button on the dialog of interest.
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The Geosoft 3D Viewer provides an interactive 3D view of your data and is used along with the 3D Tools and menu items to
interactively control the appearance of your 3D view. When you are satisfied with the appearance of your 3D view in the 3D
Viewer, simply close the 3D Viewer window (click the button in the top-right corner) and the 3D view will be displayed on
your current map.
Once a 3D view has been added to a map the 3D view can be modified by opening the 3D view using the Open 3D Viewer
button and the 3D view will be opened for edit. When you are satisfied with your changes, closing the 3D Viewer saves your
changes and displays the updated view on the current map.

3D Tools
The parameters available in the 3D Tools window are dependent on the type of 3D group currently selected. Each group
enables you modify different aspects of the 3D view within the 3D Viewer.
For more information on the individual 3D Tools options, see the “What can I do with the 3D Viewer Tools?” section in the
About the 3D Viewer Help topic (click the Help menu on the Geosoft 3D Viewer).

3D Viewing Window
Numerous interactive viewing buttons are provided on the toolbar directly above the 3D Viewing window.
For more information on the individual 3D Viewing options, see the “What can I do in the 3D Viewing Window?” section in
the About the 3D Viewer Help topic (click the Help menu on the Geosoft 3D Viewer).

Status Bar
The Status Bar across the bottom of the 3D Viewer, displays helpful navigation hints, along with the current 3D view's
coordinate system, the shadow cursor location, the view's inclination, azimuth and look-at point (center of rotation).
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